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Installing the Software 
To install the PCB Artist software, go to http://download.cnet.com/PCBArtist/ 3000-
18496_410712335.html?part=dlPCBArtist&amp%3bsubj=uo&amp%3b tag=button 
and click the download now button.  Once the download is complete, the software is 
ready to run. 

Starting PCB Artist 
During installation, a PCB Artist program icon is automatically added to your desktop 
and an Advanced Circuits program group is added to the Start menu and 
Programs.  To start PCB Artist, simply double-click on the PCB Artist icon on your 
desktop or select the PCB Artist menu item.  

  



Library Creation 
PCB Artist is supplied with a set of libraries. These libraries can be used, modified and 
added to as required. You can mix and match new and existing library items together to 
create your own set of unique libraries.  To insure the correct dimensions are used for 
the specific components, a new library with custom components is essential. 

PCB Artist libraries are easy to understand and use once your grasp the basic concepts. 
The libraries are made up of three individual libraries. There is a Component library 
made-up of elements from the Schematic Symbol library and the PCB Symbol 
(footprint) library. 

We only want to store a schematic symbol once and use it repeatedly in various 
configurations to produce different components. For instance, for the INA321 amplifier 
we have a PCB symbol library to store our 8-pin INA PCB footprint plus any other 
footprints and a Schematic symbol library for our amplifier plus any other Schematic 
symbols. These can then be used on their own or brought together (Schematic symbol & 
PCB symbol) in many different permutations to create a Component Library. We also 
have multiple Component libraries in PCB Artist to make the categorization of 
components clearer, these can be categorized by manufacturer, type, functionality etc. 

You can create a new Schematic symbol and store it in the Schematic symbol library. 
But before you can use it in a design you have to create a Component for the symbol 
and store this in the Component library for use in your designs. Typically, this is how 
power and ground symbols would be defined for example. 

Working this way, any Schematic Symbols you produce are stored with an appropriate 
name in the Schematic symbol library. It can then be reused multiple times to create 
different components using the manufacturer’s component name. Most components you 
produce will have the complete Schematic symbol and PCB symbol 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Schematic and PCB Symbol Libraries 
Two types of symbol libraries exist, those for Schematic symbols with the extension .ssl, 
and those for PCB symbols with the extension .psl. There is no limit how many symbols 
may be kept in a given library. 

Creating Schematic Symbols 
 To open the library manager 

From the File toolbar, select the Libraries icon (shortcut Ctrl+L). 
 
 
 
 

 To open the symbol manager 
From the Library Manager dialog, select the Schematic Symbols tab. 
 

 

 

 

 

 

 

 

 

 

 

 

For this tutorial, we will create a new library for each symbol/component type.  You 
could of course, add your new symbols to an existing library. 

The Symbol Editor will take a set of default design settings, such as Styles, Colors, 
Grids, Units, etc.  These are taken from a selected Technology file.  Once you 
become familiar with PCB Artist, you can customize these files using your own 
selections.  If you click on the Tech Files button on this dialog, you will see how to 
choose this Technology file.   

For now we will leave the defaults set to the ones supplied in the standard 
technology file. 

We will create a new library in which to save the new symbol into. Click the New Lib 
tab. 

 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the File name: box, type in the name ECG_Design. This will be the name of your 
new library. 

Click Save to save this file name and exit the dialog. 

The new Tutorial library is selected and is ready to have new symbols saved into it. 

You need to create a new Schematic symbol so open the Symbol Editor using the 
New Item button. 

  

 

 

 

 

 

 

For this tutorial exercise, we are going to create an instrumentational-amp 
component. The component will contain two symbols, both different. It will use an 
intrumentational-amp gate plus a power gate, we will do this to demonstrate using 
multiple gates for one component. 

You will create the op-amp gate only, the power gate (PWR) already exists in the 
supplied libraries. 

 Checking the screen dots 

Firstly, zoom in (roll the mouse wheel or click the <Z> key) so you can see the 
Screen Grid displayed.  The grid needs to be set to 50 mil so check this. 

From the File toolbar select the Grids icon. 



 
 

 

The Grids dialog is displayed. 

 

 

 

 

 

 

 

 

 

Ensure the grid Step Size is set to 50 mil steps and click OK. 

 Adding the symbol detail 

On the Schematic Symbol toolbar (the vertical toolbar on the left side of the screen) 
select Add Shape (polygon). 

 

 

 

 

Choose a starting point and create a shape 500 mil long moving down. The status 
bar at the bottom of the screen will show you the size being drawn. 

 
Notice the Symbol origin point ‘S’ at the top left of the shape. We will move this later 
on to a more relevant location. This is always added to the original of the first 
symbol item added during creation.  In order to get the triangle shape, you will need 
to take the editing mode out of Orthogonal and switch it into Free hand editing. To 
change to Free hand mode, click once to add a corner, 500 mil down (10 grid points) 
from the start point and then right click to display the shortcut menu. From the 
menu, select Segment Mode> and Free. 
 
 
 
 
 
 
 
 



 
 
 
 
 
Now you can move the ‘floating’ second segment right 500 mil and up 250 mil to 
give you the point on the triangle. Because the grid is set to 50 mil steps you will be 
able to snap to 250 mils exactly. 

 

 

 

 

 

 Adding the symbol detail 

You may need a bit more space around the existing shape to add some additional 
shape detail. Use the pan function <P> on the keyboard or press the middle wheel 
button, or use zoom out or zoom in. 

On the Schematic Symbol toolbar, select Add Shape Line. 

 

 
 

 
 
 
 
 
 

 
Select a start point 100 mils down from the symbol origin ‘S’ on the vertical segment 
(2 grid points), drag a line 100 mils (2 grid points) to the left. Like this: 
 
 
 
 
 
 
 
Use a single click to finish. 

Add the additional lines required by selecting the line you have just inserted and 
clicking <Ctrl-C> to copy and <Ctrl-V> to paste. Do this twice. Of course you can 
always simply draw them in using the Add Shape Line tool as well.  Your finished 
shape should look like the following figure. 

 

 

 
 



 Adding pins 
Pins need to be added to the Symbol to give PCB Artist ‘real’ electrical points on 
which to make connections. This gives PCB Artist its unique true electrical 
connectivity at all times. 

On the Schematic Symbol toolbar, select Add Pad. 

 

 

 

 

 

 

 

 

A pin will be available on the end of your cursor shown in the highlight color. 

Position each pin on the end of the lines so that it looks like the example below. As 
each pin is positioned, the next one in the sequence is available on the end of your 
cursor. 

 

 

 

 

 

 

 

You will see that these are auto-numbered as you proceed. After the last pin has 
been added, click the <Esc> key to cancel. 

These pins must be sequential and for this example we will number them according 
to the picture shown above.  In general, the sequence does not matter. They must 
also be unique and with no gaps in the sequence. 

Click the <A> key to position the symbol to fit the window. 

 Information on the pins 

Each pin contains three pieces of information: 

- The big cross marking the shape and location of the pin 
- The Pin Number (1,2,3 etc.) 
- The name position marker, N1,N2,N3,etc. which marks the location of the pin 

name when used on the Component in the design 

The Pin name position marker (N3) will only be populated once the Component is 
used in the Schematic design, until then you only see the name position marker. This 

 
 



 
 
 
 
You may also see the symbol origin ‘S’ character on Pin 1 if this pin was the first 
item to be added to the symbol (before the symbol shape). 

The Pin Number is then automatically numbered. This can represent the actual 
terminal number if required but can be renumbered in the Component definition. The 
number is shown in the position it will appear in when used in the design. This can 
be moved in the Symbol editor but cannot be moved once placed in the design. 

 Moving the symbol origin 
The Symbol origin is the Symbol’s reference point used when moving it in the 
Schematic design (the small ‘S’ marker). For consistency we always try and place 
this in the same relative location, usually on Pin 1 of the symbol. 

The symbol origin would have been added with the first design item. In our example, 
this was the symbol shape but it could have been the first pin added. 

Select the origin on the symbol and drag the symbol origin to Pin 1 as shown below. 
 

 

 

 

 

 

 

 Moving Pin names 

Select and drag the pin numbers (pins 1, 2, 3, 4, 5 and 6) and pin names (pins 
N1, N2, N3, N4, N5 and N6) and move them into the required location making 
sure only the name is selected and not the pin itself (the big X).   

To make sure the positioning of pin names and numbers easier and more 
refined, during the move, use the shortcut keys <Ctrl+G> to display the snap 
mode.  Change the snap to a Half Grid or Quarter Grid. 

Position the pins to look like this: 

 

 Adding the reference origin 

Without a Reference Origin, the component name (U1, IC1, etc.) used in the 
Schematic design will automatically be placed on the Symbol Origin.  By adding a 
specific Reference Origin you can position the Component name where you like. 

By default, the PCB Artist libraries have the Reference Origin placed at the 
bottom right side of the Symbol shape. 

To add the Reference Origin, select Reference Origin from the Add menu. 



 

 

 

 

 

 

 

 

Place the ‘R’ marker on the Symbol. 

 

 

 

 

 

 

 

When the Symbol is used with the component in the design, the Reference Origin is 
also used for positioning the Component Name, Package Name and PCB Symbol 
Name if these items are selected as displayed. 

You are now ready to save the symbol into the library. 

 Saving the symbol 

From the File menu, select Save. 

 

 

 

 

 

 

 

 

 

 

The Save dialog opens. 

 

 

 



Choose the ECG_Design.ssl library and give the symbol and the name ina, click 
OK. 

 Viewing the symbol in the library 

Now that the symbol has been created and saved, let’s view it in the library 
manager. 

From the File toolbar, select Libraries, you can also use the <Ctrl-L> shortcut key. 

The Libraries dialog opens. Select the Schematic Symbols tab if it isn’t already 
selected and select the Tutorial.ssl library from the drop down list. 

Ensure the Preview box is checked. 

From the Library Contents: list, select the INAMP symbol that you’ve created, it 
should look like the one below: 

 

 

 

 

 

 

 

 

 

 

 

 

Once you are satisfied with this, move onto the next section to create a PCB Symbol 
(footprint). 

 

 

 

 

  



Creating PCB Symbols (Footprints) 
 Start the Library Manager 

From the File menu, select the Libraries icon (Ctrl+L) 

 

 

 

 To open the symbol editor 

From the Library manager dialog select the PCB Symbols tab 

 

 

 

 

 

 

 

 

 

 

 

For this tutorial we create a new library to add your new PCB Symbol to. 

Click the New Lib button. 

 

 

 

 

 

 

 

 

 

 

 

In the File name box, type ECG_Design as your new PCB symbol library. Click Save to 
accept this.  The library manager is now ready to start entering new PCB symbols. 

 



 To Start the PCB symbol wizard 

For this tutorial, we will us the PCB footprint wizard.  For footprints that need 
calculating dimensions for, this is the easiest way to create them.  Since the ECG 
board is an extremely small and design specific board, this step should be done for 
each individual part on the schematic and PCB board. 

From the Library Manager window, click the Wizard button.  Ensure that you are 
on the PCB Symbols page. 

 

 

 

 

 

 

 

 

 The Footprint 

For this tutorial, we will design the PCB Symbol for the INA321.  The manufacture’s 
datasheet, which can be found at http://focus.ti.com/lit/ds/symlink/ina321.pdf, 
provides us with footprint pattern dimensions. The footprint, from the datasheet, is 
shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Using the footprint wizard 

Click the Wizard button. 

From our example footprint shown above, the other aspect you’ll notice is how exact 
the range of dimensions is.  This exactness also gives you a level of vagueness as 
you need to know how the footprint will be manufactured before being able to 
complete it. 

The first page you are presented with is Start. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click the Next> button to move forward and start the new symbol.  Across the 
bottom of the page are always located the <Back, Next>, Cancel and Help 
buttons, which may be used at any time during the wizard. 
 
The next page is used to choose a possible Technology file and the Units to be 
used. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No technology file will be used.  We will change the Units to Metric and the 
Precision of 2.  We will use a precision of 2 because our datasheet measurements 
are within that same precision.  Our footprint is very small and will require a pin 
pitch of .5mm.   



The preview pane (shown on the right in the Footprint Type window) will display a 
symbol.  This symbol is a graphical representation of the current shaped and differ 
depending on the component you are designing.   

Click Next> to move on. 

On the type page, select the SOIC shape.  Your preview will now change to 
represent a SOIC device. 

On Origin, select Center.  Since the ECG board has such tight space requirements, 
all components for the ECG PCB design will be surface mount.  For a surface mount 
(SM) component, having the Origin at Center is normal.   

For Component Name position, click the bottom right radio button.  You’ll see the 
preview update. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click Next> to move on. 

The Pads page is used to define the overall footprint layout.  This is probably the 
most important page of the wizard.  The default page setup is shown below, we need 
to change the parameters defined here. 

 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 

From the given datasheet, observe that the INA321 has 8 pins.  Since the INA321 
has 8, the Pad Count should be set to a Total of 8.  You can use the spinner or type 



in the number to change it.  You must type in the name of the pad Style that will get 
saved once you’ve edited the dimensions. Use Rectangle for the specific pad style. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

In Measurements, you need to enter the dimensions to be used.  These dimensions are 
located on the datasheet provided, or you can find it at the Texas Instruments link 
provided: http://focus.ti.com/lit/ds/symlink/ina321.pdf.  The correct dimensions have 
been highlighted for our footprint; all are in mm. 
 

e 0.65 
E 4.90 
PW Automatically calculated 
PL Automatically calculated 
L 0.55 
T 0.05 
H 0.05 
b 0.32 

 
You must now choose the position for Pin 1 to be the bottom left corner, to Hide Pin 
Numbers and the Pin Numbering to be Counter-clockwise. 

 
 
 
 

 
 

Click Next> to move on. 
 
You should now define the Silkscreen outline. 
This dialog is setup by default to assume you will always require a silkscreen outline.  
The only parameter to change here is the Notch At End value, change this to 0.50. 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click Next> to move on. 
 
We will use the placement shape and add it to the Documentationa1 layer.  Select this 
layer from the drop down list. 

 
 
 

 

 

 

 

 

 
 

Click Next> to move on. 

In the Footprint Name: box, type INA321. 
Check the Save the footprint to the library box. 
Select your ECG_Design.psl library from the drop down list. 
Leave the Edit the footprint now check box unchecked. 

 

 

 

 

 

 



Click Finish to complete the footprint creation. 

 Viewing the symbol in the library 
 
Now that the symbol has been created and saved, let’s view it in the library 
manager.  From the Libraries button on the File toolbar, select Libraries, shortcut 
key <F11>.  Select the newly created footprint from the contents list (INA321).  
Check the Preview box if not already selected so you can view the footprint.  You 
can also edit it from here as well. 

 

 

 

 

 

 

 

 

 

 

 

The footprint is now ready to be used in a component. 

  



Creating Surface Mounted Footprints 
Surface Mounted pads of the PCB Symbol are easy to create, and will be necessary for 
most of our ECG components.  The only consideration needs to be for the side that the 
pads reside on.  For normal pads, this would be the [All] layer.  This means that the 
pad occupies all of the layers in the design. Whereas a surface mounted (SM) pad would 
only occupy the outer layers [Top] or [Bottom]. 

All surface mounted pads are defined on the Top layer.  When used in the PCB design, 
the component is flipped to the other side of the board (Bottom).  For the ECG PCB 
design, all components will be mounted on the top layer of the board. 

 Change the layer of the pad 
 
During the addition or once the pad has been added, the layer can be changed.  You 
may also find that you need to change the pad style as well. 
 
Select the pad(s) and right click.  From the menu, select Change Layer <L>. 
 
 
 
 
 
 
Select the New Layer from the drop down list. The Old Layer: box will display the 
current layer used. 
 
An alternative method is to use the Pad Properties, also on the shortcut menu.   
 
 

 

 

 

 

 

 

 

 

The Layer: drop down list will contain legal layers for which to swap your pad to.  
You should be aware that there may also be a Pad Style change required, especially 
to note is a drill hole and plated status of the current pad style. 

Click OK to accept the change. 

 

 



Creating Components: Using the Component Editor 
This tutorial uses the Schematic Symbol and PCB Symbol (Footprint) created in the 
previous tutorials, but equally applies to creating a component using other Schematic 
Symbols and PCB Symbols. 

 To open the Component editor 
On the File toolbar click Libraries <F11> or <Ctrl+L>. 
 

 

 

 

From the Library manager select the Components tab.  For this tutorial, we will 
use the same library we have used for our Schematic Symbol and PCB Symbol 
(Footprint). 

 

 

 

 

 

 

 

 

 

 

Click the New Lib button. 

 

 

 

 

 

 

 

 



In the File name box, type ECG_Design as your new component library. 

Click Save to accept this. The library manager is now ready to star entering new 
componenets.  We need to create a new component so cline on New Item.  The New 
Component dialog box opens.  There are 8 pieces of information required: 

 In the Component: box type the component name INA321 
 In the Package: box type SOIC, this identifies the package type, multiple 

package types can be used for selecting alternative footprints. 
 In the Default Reference: box type U.  This will be the component name used 

in the actual design (or seen on the silkscreen of the PCB) 
 For Schematic Symbol, ensure that the library is set to ECG_Design.ssl.  Select 

your Schematic Symbol previously created ina from the list.   
 The dialog will automatically show Pins: as 6 and Gates: as 1.  Change the 

Gates: to 2.  This will add another to the component. 
 For the PCB Symbol, ensure that the library is set to ECG_Design.ssl. Select 

your PCB Symbol previously created INA321. Ensure that the Pins box shows 8 
to verify that you PCB Symbol is correct. 

 Your diaolg is complete and should look like the one below: 

 

 

 

 

 

 

 

 

Once it does, click OK to continue. 

The Component Editor opens showing the items added from the New Component 
dialog. 

The Component Editor now looks like this: 



 

 

 

 

 

 

 

 

 

 

 

So far we’ve given the Component a Name, selected the name default reference 
name stem to be used and selected the Schematic and PCB Symbols to be used. We 
now need to add more detail to the component to give it more intelligence. 

 Adding an extra gate 

We need to add a power gate to the component. There are various methods in PCB 
Artist to adding power and ground to the component, for now this is one of the 
easiest. 

Right click anywhere in the component grid. From the list, select Edit Gates. 

From the Gates dialog, select the Add button. Notice your existing 2x OPAMP gates 
are already shown in the list as gates a & b. 

From the Library: list select the AD.ssl library. 

 

  



Scroll down the Name: list and select the AD-P2 gate symbol. Ensure that you only 
have 1 selected in the Add 1 Gates box. Click the Add button. 

 

 

 

The Power gate will appear at the bottom of the list. Click OK to add it to the 
component. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The power gate will now appear at the bottom (as the last gate) in the component grid 
and in the Schematic Symbol preview. 

Now we need to add more detail to the component and to ‘map’ the pins used in the 

Schematic Symbol to those that will actually be used in the PCB Symbol. 

 Mapping pins to pads – why? 

For a Component to work, it needs to know how the pins defined in the Schematic 
Symbols relate to the pads used in the PCB Symbol. This mapping is presented in a 
‘grid’ format in the component editor. 

You can map the pin relationships manually or automatically by using the tools 
provided. On complex devices like a 256 pin BGA, the automatic method may be 
more preferable than the manual method which may be better for resistors for 
example. 



You can use three methods: you can directly type the pad numbers into the 
respective grid cells or you can use the Assign Pins modes that let you click on the 
Schematic Symbol pin first and then the equivalent PCB pad. You also have the 
Assign Pins 1:1 which automatically assigns pins on a 1 to 1 basis, Schematic to PCB 
symbol. 

 To map pins to pads 

Generally speaking, you will use the Assign Pins method most times to do this task. 
This enables you to manually click on the Schematic symbol pin and then the 
corresponding PCB pin. 

Click on the Assign Pins button on the Component toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The natural pin mapping of the Schematic Symbol and the PCB Symbol during 
creation will not be the same and will not necessarily be the correct sequence for 
mapping. PCB pins generally drive the mapping. However, for this specific example, 
we have considered the number sequence of the Schematic Symbol during the 
creation, which allows us to follow more closely the PCB pin sequence. 

Consider the component and schematic symbol shown below. We will number our 
pins according to these pictures.  

 

 

 

 



Select Pin 1 on the Schematic Symbol. 

Select Pad 1 on the PCB Symbol. 

The component grid will display the number 1 for Sch Terminal Number 1 on gate 
a, it will also display a number 1 in the corresponding Component Pin 
Name/Number cell. 

As you see, we have chosen to map the first pin on the Schematic Symbol to the first 
pin of the PCB Symbol because they correspond to each other.  Map the other pins 
accordingly. 

Once assigned, a number 1 will be shown on the Schematic Symbol output pin (pin 
1). The color of the Schematic Symbol and PCB Symbol pins will also change color to 
reflect this. A different color will be shown for assigned and unassigned pins, and the 
currently selected pin. 

You should complete all pin to pad mapping so that looks like this: 

With the assignment of all pins between the Schematic and PCB symbols, this would 
be considered a minimum configuration to be able to save the component to the 
library and then use it in a design. Other information can be added and is discussed 
below after saving the component. 

 Saving your Component 

From the File toolbar, select Save <Ctrl-S> 

 

 

 

 

The Save To Library dialog opens. 

 

 

 

 

 

Choose the ECG_Design.cml library from the list if not already selected. 

You entered the Component editor through the New Item dialog and have already 
given the component a name. This name will be displayed. 



Click OK to confirm the library name and component name. You have now saved the 
Component in the Library. The component will still be visible in the editor. We will 
edit it some more so keep it open for now. 

 Viewing the Component in the library 

From the File toolbar, select Libraries, <F11> or <Ctrl-L> 

The Libraries dialog opens. Select the Components tab if it isn’t already selected. 

Make sure the Preview box is checked. 

Select the INA321 Component that you created, it should look like the one below. 

 

 

 

 

 

 

 

 

 

 

 

 

A quick check to see whether you have created is correctly is the existence of both 
the Schematic and PCB Symbols in their respective Preview windows. 

At this stage, you would add this component to a Schematic or PCB design and it 
would work. 

Creating the Rest of Your Components 
The rest of the components, with the exception of the OPA4336, are very simple to 
create.  The Schematic Symbol for both the resistors and capacitors do not require 
designing, they can be added from the Discrete.ssl schematic library, using the Add 
File button in the Schematic Symbol window.  

The PCB Symbol does require using the Wizard.  This allows you to design each resistor 
and capacitor to the size of the actual component that you will be ordering.  For further 
help go to the PCB Artist Library Creation Tutorial, which is located at the following web 
address: http://www.4pcb.com/downloads/pcbartist/PCBArtistLibraryTutorial.pdf  

 

    



Schematic Design Tutorial 
Fortunately, the Schematic from which the ECG PCB Design will be made has been 
supplied to us by Dr. Fei Hu.  Open the file from the extension you have it saved at.  
Your PCB Artist window will look like this ready to start: 

 

 

 

 

 

 

 

 

 

 

 

 

The next stage is to convert the design into the PCB design environment 

Although we will not cover how to create this schematic in this tutorial, there is some 
useful information located in the PCB Artist tutorial, which can be found at the following 
web address: http://www.4pcb.com/downloads/pcbartist/PCBArtistTutorial.pdf 

 

  



Converting the Schematic to PCB 
If you created a Schematic in PCB Artist, the final process before starting on the PCB 
design itself is to translate the Schematic design into the PCB design editor. 

When you are in a position where you wish to go-ahead with this translation you should 
select Schematic <- - > PCB > and use the Translate To PCB option from the Tools 
menu. 

 

 

 

 

 

 

This will display the New PCB wizard. 

Starting a New PCB Design 
You do not have to create a PCB design from a Schematic design.  If you intend starting 
a new PCB design without using a Schematic design first, from the File menu select 
New and check the New PCB Design radio button. Click the OK button and this will 
start the New PCB Wizard. However, we already have our Schematic design, and will 
definitely be creating our PCB design from this.   

Getting Started with the Design 
PCB Artist PCB is flexible in that you can start your layout in two ways: 

 Use PCB Artist Schematic Capture as the 'front-end' to the PCB system. The nets 
and components are converted to PCB in the integrated environment. 

 Use the PCB Artist PCB design editor interactively creating the design on-the-fly 
without the need for an initial netlist. You just add components and connections 
as required to create the PCB design. 

Converting the Schematic to PCB 
If you are following the tutorial, you would have already processed your ‘logical’ 
Schematic design into the ‘physical’ PCB design layout editor using the Schematic To 
PCB wizard. If you didn’t do this, go back to the previous chapter (Chapter 3 - 
Converting your Schematic to PCB) and convert your schematic into a PCB design. 

At this point you are ready to start laying out the PCB design. You will see the board 
outline ready to place the components in. We previously chose to leave the components 
unplaced and the nets unrouted. These two features can both be selected during the 
final conversion process. 

  



Adding Components 
 To add a component 

There are two methods for adding components; we will use the Interaction bar 
to start with, you can also use the Add Component option as well.  The 
Interaction bar can be displayed by clicking the <F9> shortcut key. 
 
Select the Add Component browser tab at the bottom of the Interaction bar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
From the list of available libraries, select the ECG_Design library.  Click on the 
small down arrow to reveal the drop down list and then make the selection.  
Notice, in this list, all the required components to design the schematic have 
been made.  As said in the last part of the Creating Components tutorial, you will 
have to make these parts on your own. 

  



 
What’s left: 

- Mapping the Pins to the correct pads so the functions of each gates are correctly 
defined 

- A brief statement to address using these three steps to create all of the 
components and using them to create a PCB design 

- Wiring and layout issues: 
o Making sure the pad is 20 mils larger than actual component 
o No 90° angles for the wire routing 
o Advantages of having an entire ground plane/layer  
o Others? 

- How to verify? 

 

 


